
 BulkRate Windows

Service window

 

his window contains information for the currently active Service, as well as 
clickable icons that act as shortcuts for exchanging mail and opening 
incoming or outgoing mail.

The host name is the name you wish to use to identify the BBS.    If you call 
multiple BBSs, make sure each has a unique name.    If you have multiple 
Service files for a single BBS, all files should have the same host name 
entered here.

The UserID and Password must be identical to those used in FirstClass® 
Client.    An easy way to insure this is to have BulkRate pull the UserID and 
Password from a FirstClass® Settings file.    Simply choose "Open service..."
from the Service menu and choose a FirstClass® settings file.    BulkRate 
will create a new Service file and enter host name, UserID, password, and a 
phone number for you.    You must still adjust your Mailbox settings, 
Exchange settings, File transfer settings and Modem settings.

When you type in a password, it will appear in readable text.    Hit the tab 
key to convert it to "bullets" for security.    Clicking back into the Password 
field will make the password readable again.    

You may enter multiple phone numbers; BulkRate will dial each one in turn 
if it encounters a busy signal.



Click "Exchange mail now" to start a mail exchange.    Click "Incoming mail" 
or "Outgoing mail" to view the respective mailboxes.

Incoming message list window

 

his window shows you a list of all messages in a incoming mailbox.    You 
may read any item in the list by double-clicking on it.    Option-clicking an 
item toggles the flag which indicates that a message has been read.    You 
may also mark a message as unread by choosing "Mark as unread" from the
Mail menu.

You can sort the list by Conference, Name, Subject, Date or read/unread 
Status using the View menu.    The "by Default" sort type simply shows you 
the items in the order they are stored in the file.

You may delete items by selecting them and choosing "Mark for Delete" 
from the Mail menu, or clicking the Delete button on the Palette.    This 
marks the items with a trashcan icon.    When you close the list window, 
these items will be removed from the file.

Choosing Forward from the Mail menu, or clicking the Palette FWD button 
will allow you to forward a selected message to another recipient.

Choosing Reply from the Mail menu or clicking the Palette REPLY button 
will create a reply to a selected message.    It's better to reply to a message 
that is open, however, as this allows you to quote text from the original 
message.



Incoming message window

 

ou may read an incoming mail item using this window.    You may copy and 
edit text and change the font and size of selected text, but no changes are 
saved when you close the window or advance to another message.    You may
quickly advance to the next message by pressing the return, enter or right 
arrow keys.    You can return to the previous message by pressing the left 
arrow key.    You may also use the Mail menu or Palette for more navigation 
options.

The space    bar can be used to somewhat intelligently step through 
messages: the current thread will be followed until there are no messages 
left in the thread, then it will read the first unread message in the list; 
follow its thread, if any, and so on until all unread messages are read.

Choosing Forward from the Mail menu, or clicking the Palette FWD button 
will allow you to forward this message to another recipient.

Choosing Reply from the Mail menu or clicking the Palette REPLY button 
will create a reply to this message.    If you wish to quote part of the 
message text in the reply, select the text before choosing or clicking "Reply."

If the message has files attached to it and you haven't configured BulkRate 
to automatically download file attachments, you may request that BulkRate 
retrieve any attached files on the next mail exchange by choosing "Request 
file" from the Mail menu, or clicking the RQST button on the Palette.



Clicking the Palette DEL button or choosing Mark for delete from the Mail 
menu will mark this message for deletion and advance to the next message.

Outgoing mail list window

 

his window is similar to the Incoming mail list window. It displays a list of 
all messages in an outgoing mailbox.    Option-clicking an item toggles the 
sent flag, which looks like a postmark.    This flag indicates that a message 
has been sent; items waiting to be sent will have no icon.    Items that have 
been put on "hold" will have a hollow flag icon, and items marked for 
deletion will have a trashcan icon.    Items that were attempted to be sent, 
but failed, will be indicated with a circle-with-a-slash icon.    You can check 
the log for details as to why this message wasn't sent.    BulkRate will also 
send you a "non-delivery notification" which will appear in your incoming 
mailbox.    In most cases, the problem is an addressing problem.

You may sort the list by Host, Name, Subject or sent/unsent Status by using 
the options available under the View menu.    Again, the "by Default" sort 
type simply displays the items in the order they exist within the mailbox file.

You may delete items from this list by selecting them (shift-click and 
command-click are supported) and choosing Mark for delete from the Mail 
menu or clicking the DEL button on the Palette.    This marks the items to be
deleted when the window is closed.

Outgoing mail window

 



se this window to edit outgoing mail.    Once you've created a new message, 
you can either Save it (under the File menu) or Queue to Send it (under the 
Mail menu).    Both actions are equivalent; Queue to Send (or the Palette 
"Post" button) takes the additional step of closing the window after saving 
the message in the outgoing mailbox.    Due to limitations of the FirstClass®
CLUI, outgoing messages over 5K in length will be automatically split into 
multiple parts when sent.    The FirstClass CLUI also does not recognize 
extended characters when composing mail.    Any extended characters you 
enter in the subject or body text of an outgoing message will be converted 
to regular ASCII text when the message is sent.    For example, "Günther" 
will be converted to "Guenther", and "BulkRate©" will be converted to 
"BulkRate(c)".

When editing an outgoing message, you can add addresses to the To or cc 
fields manually, or by using the Address Book.    

"Host:" contains the host name of the BBS this message is to be sent to; 
usually BulkRate fills this in for you.

The "Message sent" checkbox will be checked if you are viewing or editing a
message that has already been sent to the Host BBS.    You can also 
manually toggle this to resend the message.
The "Hold message" checkbox can be checked to prevent BulkRate from 
sending a message.    You can then finish it at a later time and then uncheck 
this box.    This checkbox changes to "Delete message" if the message has 
been sent.



The "Threaded reply" checkbox indicates whether or not a message is a 
threaded reply.    Uncheck this box to de-thread the reply.    Do not uncheck 
this box on a file request, or the file request will fail.

Clicking the Palette DEL button or choosing Mark for delete from the Mail 
menu will mark this message for later deletion.

Address Book window

 

his window simply contains a list of names, addresses, and services.    If an 
outgoing message is directly under the Address Book window, double-
clicking on an entry (or selecting an entry and clicking the "Use" button) 
will add that address to the To field, unless the cursor was in the cc field, in 
which case the address will be added to the cc field.

Another way to use the Address Book is to simply type the name into the To 
or CC fields of an outgoing message.    When you hit return, enter, or tab, 
the name will be replaced with the address you've entered (and a comma 
and the Host Service, if applicable).    For example, if you typed "Greg 
Neagle" and hit return, "Greg Neagle" would be replaced with 
"greg_neagle@pop.com,Internet".

 



ou may edit the items in the Address Book by clicking the Edit button, 
which expands the window to include the editor section.

Add an address by typing it in the fields in the editor section and clicking 
"Add".
You can add, delete, and replace Address Book items, open other address 
book files, or save the current Address Book as a new file.    Any Address 
Book file that is open when you quit BulkRate becomes the default Address 
Book and will be reopened the next time you launch BulkRate.

Address Book edit fields:

Name:    Stores the name of the addressee: you can put anything you want 
here, like "Dad", or "BulkRate tech support" - whatever name allows you to 
easily remember the entry.

Address: This is the actual FirstClass® address or gatewayed address.

Host service:    If the person is accessed through a gateway, this is the name of
the gateway or FirstClass® BBS accessed through a gateway. In 
FirstClass®, the part of the address after    the comma.    Otherwise, this 
name should EXACTLY match the Host name in the Service window, or you 
can leave it blank.

Notes:    Use this field to store a note or memo concerning the current entry.   
It will only be visible while editing the Address Book.

Palette window

 



his window serves much like FirstClass® Client's palette window - it gives 
you easy one-click access to many message navigation and creation 
functions.    Normally the Palette opens in a vertical configuration, but if you
hold down the option key while choosing "Palette" from the View menu, it 
will open in a horizontal configuration.    As long as the Palette is open while 
you quit BulkRate, it will re-open automatically in the same configuration 
when you relaunch BulkRate.

Palette buttons:

NEW: creates a new outgoing message in the outgoing mailbox for the 
currently open service.

POST: Queues an outgoing message to be sent. (The outgoing message is 
saved in the outgoing mailbox and the window is closed.)    Note that this 
mail is not actually sent until you choose "Exchange mail now" or otherwise 
initiate a mail exchange.

REPLY: Creates a reply to the current incoming message.    If you have 
selected text in the incoming message before clicking "REPLY," the text will 
be quoted in the outgoing message.

FWD: Creates a new outgoing message that forwards the text of the current 
incoming message to new recipient.

ATTCH: Attaches a file to an outgoing message.

RQST: Request that an attached file be retrieved from the server on the next 
mail exchange.

FIND: Allows you to find text in a mailbox or the log.    Holding the option key
down as you click this button is the same as choosing "Find text again" from



the menu.

DEL: Marks for deletion the currently open message, or any selected 
messages in a list window.

PREV THRD: (Previous in Thread) Finds the first previous message with the 
same subject as the current message.    This is not "true" threading, but is 
the best possible approximation.

NEXT THRD: (Next in Thread) Finds the next message with the same subject 
as the current message.

FIRST UNRD: (First Unread) Finds the first unread message in the list.

NEXT UNRD: (Next Unread) Finds the next unread message after the current 
message.

PREV MSG: (Previous message) Displays the previous message.

NEXT MSG: (Next message): Displays the next message.

Mail log window

 

his window displays the contents of the BulkRate log, which can be useful 
for troubleshooting, reviewing the actions a script accomplished, 
determining why certain messages were not sent, or determining logon and 
logoff times.    BulkRate only saves the last 30-32K of activity.

Exchange Status window

 



his window is visible whenever a mail exchange is in progress.    It displays 
information about the current exchange.    Click the Cancel button to cancel 
an exchange in progress.


